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Get Help
There are a number of ways to learn more about your product and interact with Oracle and other users.

Get Help in the Applications
Some application pages have help icons    to give you access to contextual help. If you don't see any help icons on
your page, click your user image or name in the global header and select Show Help Icons. If the page has contextual
help, help icons will appear.

Get Support
You can get support at My Oracle Support. For accessible support, visit Oracle Accessibility Learning and Support.

Get Training
Increase your knowledge of Oracle Cloud by taking courses at Oracle University.

Join Our Community
Use Cloud Customer Connect to get information from industry experts at Oracle and in the partner community. You
can join forums to connect with other customers, post questions, suggest ideas for product enhancements, and watch
events.

Learn About Accessibility
For information about Oracle's commitment to accessibility, visit the Oracle Accessibility Program. Videos included in
this guide are provided as a media alternative for text-based topics also available in this guide.

Share Your Feedback
We welcome your feedback about Oracle Applications user assistance. If you need clarification, find an error, or just
want to tell us what you found helpful, we'd like to hear from you.

You can email your feedback to oracle_fusion_applications_help_ww_grp@oracle.com.

Thanks for helping us improve our user assistance!
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1  Get Started with Configuring Sales
Forecasting

About Forecasting for Oracle Sales in the Redwood User
Experience  
Sales managers need to accurately forecast their team's committed forecast so that their Sales in the Redwood UX team
is on track to meet or exceed their quota. Sales forecasting helps them to manage the team members’ forecasts and roll
the pipeline up by forecast category into their periodic forecast view. For example, your sales organization can forecast
opportunity owners in each quarter and managers can adjust those forecasts as needed.

Sales Forecasting for Redwood UX allows for real-time visibility into forecasts and the ability to make summary and
line-item adjustments, fostering effective collaboration and communication within sales teams. A key feature is the
highly interactive drag-and-drop functionality, which allows managers to swiftly apply executive judgment and improve
forecast accuracy.

Forecasting for Sales in the Redwood UX caters for two broad forecasting scenarios, and both need different setups:

• Forecast by Opportunity Owner (Default)

◦ This forecast scenario uses opportunity owners and rolls up the resource reporting hierarchy. Territories
aren't required in this forecasting approach. This means that opportunity revenue is automatically
included in the forecasts of the opportunity owner. Salespeople own their opportunities and forecast
them. The forecasts are passed up the resource hierarchy for adjustment and endorsement. Your
organization doesn't use territories to assign salespeople to opportunities.

• Forecast by Opportunity Revenue

◦ Forecasting by opportunity revenue is an alternative forecasting type for Redwood UX forecasting users.
This forecast scenario uses opportunity revenue forecasting when you use sales territories to assign
opportunities. You assign opportunities to sales territories by geography, product, industry, and other
dimensions. The opportunity owner isn't necessarily the sole person forecasting the revenue. You might
have multiple salespeople from different parts of the sales organization involved in the sale.

For information about Sales in the Redwood UX and its rich set of features that make life easier for sales teams, see
Overview of Oracle Sales in the Redwood User Experience.

How do I enable Sales Forecasting for Redwood UX?  
Forecasting for Sales in the Redwood user experience allows for real-time visibility into forecasts and the ability to make
summary and item changes, fostering effective collaboration and communication within sales teams. Before you can
start configuring Sales Forecasting for Redwood UX, you must be an administrator with the assigned configured job
role.

1
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Forecasting for Redwood UX caters for two broad forecasting scenarios, and both need different setups:

• Forecast by Opportunity Owner (Default)

◦ This forecast scenario uses opportunity owners and rolls up the resource reporting hierarchy. Territories
aren't required in this forecasting approach. This means that opportunity revenue is automatically
included in the forecasts of the opportunity owner. Salespeople own their opportunities and forecast
them. The forecasts are passed up the resource hierarchy for adjustment and endorsement. Your
organization doesn't use territories to assign salespeople to opportunities.

• Forecast by Opportunity Revenue (forecasting when you use sales territories to assign opportunities)

◦ You assign opportunities to sales territories by geography, product, industry, and other dimensions. You
might have multiple salespeople from different parts of the sales organization involved in the sale. The
opportunity owner isn’t necessarily the sole person forecasting the revenue. The forecasts are passed
up the territory hierarchy for adjustment and endorsement. If your implementation meets any of these
criteria, then you must set up sales territories and run the Request Revenue Territory Assignment process
to assign territories to opportunities.

Before You Start
To enable Sales Forecasting for Redwood UX, you must have the following privileges.

Privilege and Name Description

ZSF_SETUP_DIGITAL_SALES_FORECAST
 
Setup Sales Forecasting from Digital Sales
(Redwood UX)

Allows setting up sales forecasting and running processes from Redwood UX.

ZSF_EXPORT_IMPORT_DIGITAL_SALES_
FORECAST_QUOTAS
 
Export and Import Sales Forecast Quotas
from Digital Sales (Redwood UX)
 

Allows exporting and importing sales forecast quotas from Redwood UX.

ZSF_MANAGE_DIGITAL_SALES_
FORECAST_QUOTAS
 
Manage Sales Forecast Quotas from
Digital Sales (Redwood UX)

Allows viewing and editing sales forecast quotas from Redwood UX.
 

Note:  This privilege isn't a requirement but rather a recommendation to help show the best of the
Sales Forecasting for Redwood UX capabilities.

 

Set the Forecasting Currency
Set the profile option ZCA_COMMON_CORPORATE_CURRENCY to enable the forecast to appear in your preferred
currency. The currency value entered sets the corporate currency for opportunity records. When an opportunity is
created, it uses the user preference currency from the user's regional settings. If there's no user preference, then
corporate currency is used.

2
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Configure Sales Forecasting for Redwood UX
Go to the Navigator > Redwood Sales > My Forecasts to start configuring Sales Forecasting for Redwood UX using
the guided process. You can also select the Configure Forecasting menu item from the Actions drop-down list on the
Forecast Overview page.

Note:  If you update your forecasting configuration options, then all forecast metrics will be recalculated and any
adjustments made will be deleted.

See Configure Sales Forecasting Using Guided Process  for more information.

Generate Sales Forecast Metrics
Go to the Navigator > Tools > Scheduled Processes and run the Generate Sales Forecast Metrics process.

See Generate Sales Forecast Metrics for more information.
The Generate Sales Forecast Metrics process automatically generates sales forecast metrics for salespeople for each of
the active forecast periods. For example, sales managers can view the best case opportunities or those that their team
members have committed to so that they can help move the opportunities to the Won status. They can also view and
make adjustments where necessary to the forecasts, unforecasted, and sales forecast quota items for each of their team
members.

Schedule the Generate Sales Forecast Metrics Process
Typically, you run the Generate Sales Forecast Metrics process once for each forecasting period. You can run this
process if the forecast metrics become distorted. See Generate Snapshots of Sales Forecast Metrics and Adjustments in
the Sales Forecasting Processes section for more information.

Secure Sales Forecasts Using Access Group Rules  
Use access group rules to control access for salespeople using the sales forecasting in the Redwood UX. For example,
you can secure sales forecasting access for sales managers and salespeople based on opportunity ownership and their
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resource hierarchy. Or, you can secure sales forecasting access based on forecast territory ownership and the territory
hierarchy.

Using access group rules lets you extend visibility to forecasting data. This can be useful if the territory hierarchy
and territory-based reporting and rollups are different to the reporting resource hierarchy. You can also define sales
forecasting data access for your custom sales job roles.

Here's an example of some predefined sales forecast access group rules available to you.

If you use the default Sales Manager, Sales VP, Sales Representative, Restricted Sales, Sales Administrator and Customer
Relationship Management Application Administration job roles, then no additional setup steps are necessary.

Following the first run of the Generate Sales Forecast Metrics process, run the Perform Object Sharing Assignment
Rule Processing scheduled process After that, the process is automatically scheduled to run on an ongoing regular
basis.

4
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Custom Job Roles for Sales Forecasting
If you use custom job roles for your sales organization, you must manually associate the appropriate sales forecast
rules to your custom job role access groups to setup sales forecast access for your salespeople, operations, and
administrators.

• Define an access group for each custom job role

• Associate groups with appropriate sales forecasting rules

• Publish rules (and confirm process completed successfully)

• Submit the Perform Object Sharing Assignment Rule Processing process with following options:

◦ Object: Sales Forecast

◦ Record Selection: All Records

It's recommended to run the Daily Refresh Sales Forecast Dimension process in advance of running the Perform
Object Sharing Assignment Rule Processing job so that any changes in resources or territories and their hierarchies
are reflected in the access to sales forecasts.

Note:  Sales forecasting doesn't support custom access groups.

See Overview of Access Groups for more information about access groups.

5
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2  Configure Sales Forecast Using Guided
Process

Configure Sales Forecasting Using Guided Process  
Sales administrators can configure the sales forecasting process to suit the implementation requirements of your
organization. A guided process guides the administrator through a series of setup screens as outlined here.

The configuration process guides you to:

1. Set Sales Forecast Type and Period Parameters
2. Set Sales Forecast Categories and Mappings
3. Select Filter Options for Sales Forecasts
4. Review and Submit Sales Forecast Parameters and Processes

Set Sales Forecast Type and Period Parameters
The first UI in the process lets you make a series of setup choices such as selecting the forecast type and period you
want to configure.

From the Forecast type step in the Configure Sales Forecasting guided process:

1. Select the Forecast Type you want to use for your sales forecasting process from the drop-down list. You can
choose from one of the following:

◦ By opportunity rolling up resource hierarchy

◦ By opportunity revenue rolling up territory hierarchy

7
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2. Select the Forecast Period and decide on the Number of Active Periods you want to forecast.

These are the periods displayed in the period drop-down list in the forecasting pages. Valid values include:

◦ Minimum: 1

◦ Maximum: 5

The default value is 2.

Use the salesForecastParameters REST service to change the default value.
3. Select the Show Sales Quotas checkbox to display and edit sales quotas as part of your forecasts. This option

is enabled by default
4. Click Continue to move to the next step.

Set Sales Forecast Categories and Mappings
From the Forecast categories page, you select the available metrics in sales forecasting and map the opportunity or
revenue win probability values to each forecast category for updating opportunities in the forecast active periods.

Note:  This is a one-time update of the forecast category for opportunities in the active periods. To set the forecast
category to best case or committed on opportunities on an ongoing basis, Oracle recommends using Routines or a
Groovy script. Your sales administrator can use Groovy scripts to automatically set the forecast category to Best Case
or Committed for open opportunities based on the progression of the opportunity. See Use Routines and Groovy
Scripts to Set Forecast Category Values for more information.

8
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Based on the options selected, this step updates the open and closed opportunities with a close date in one of the
active periods and set the opportunity forecast category values as defined.

Note:  This setup enables existing open, closed, and won opportunities to be updated with the desired forecast
category values so that the opportunities appear in the forecast when you enable Sales Forecasting for Redwood UX.
See About Opportunity Forecast Categories for more details.

From the Forecast categories page:

1. Select the sales forecast metrics to use by enabling the checkbox values that you want.
2. From the Sequence drop-down list, select the sequence you want to display Opportunities in your forecast and

graphical pages.
3. In the Forecast category mapping section, map the win probability values to each forecast category for one-

time updates of opportunities for the active periods you selected in step 1, Forecast type of the guided process.

Note:  You can click Edit forecast categories to edit the forecast category names and enter low and high
percentage values to suit your requirements.

4. Click Save and then Continue to the next step.

Select Filter Options for Sales Forecasts
The Filter options step 3 lets you select the object and the options by which you want to filter your forecasts.

9
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From the Filter options page:

1. Select Opportunity from the Object drop-down list.
2. Select the options you want to filter forecasts by enabling the checkbox values that you want.
3. If any custom dimensions are defined, then select the dimension to enable it in forecasting, and if multiselect is

appropriate for filtering, then select Allow multiselect.
4. Click Continue to move to the next step.

Review and Submit Sales Forecast Parameters and Processes
From the Review and submit final step 4, you can review a summary of the configuration information you selected in
the previous steps.

10
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You can go back to previous steps to make further changes if required. Otherwise, if you're ok with your selections, click
Submit.
See Generate Sales Forecast Metrics in the Sales Forecasting Processes section for more information.
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3  Working With Sales Forecasting

About Opportunity Forecast Categories  
Sales managers and sales representatives can use the opportunity forecast category feature to indicate whether an
individual opportunity or revenue line is included in their best case or forecast commitments. Forecast category is a
cascading field so the value from the opportunity is automatically cascaded down to the revenue line.

The forecast category is set by default as follows:

• Create opportunity defaults to Pipeline

• Close opportunity as won defaults to Won

• Close opportunity as lost defaults to Omitted

Here's an example of Opportunities in Forecast for a sales manager.
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Your sales administrator can use routines or groovy scripts to automatically set the forecast category to Best Case or
Committed for open opportunities based on the progression of the opportunity. See Use Routines and Groovy Scripts
to Set Forecast Category Values for more details.

The opportunity forecast category is available by default in the Opportunity Adaptive Search index. Also, the revenue
forecast category is available to be added in the Revenue Adaptive Search index.

Add the Forecast Category Field using VB Studio
If required, your sales administrator can add the Forecast Category field to appropriate Opportunity UI pages so that
salespeople can update the forecast category to reflect their forecast commitments. Here’s an example of using VB
Studio to configure the forecast category field for the Opportunity Details page.
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Here's a sample screenshot of the Forecast Category field along with its drop-down list values.
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Use Routines and Groovy Scripts to Set Forecast
Category Values  
You can use routines or Groovy scripts to set the Best Case and Committed forecast categories. For example, your sales
administrators can allow salespeople update the forecast category based on win probability, sales stage, or any criteria
on the Opportunity details page or on the Edit Products (revenue lines) page. They can also use Groovy scripts on an
ongoing basis to set the opportunity forecast category to Best Case or Committed.

Routines
Routines can be used on an ongoing basis to set the opportunity forecast category to Best Case or Committed. You can
use separate routines to update the forecast category based on win probability or other business criteria. For example:

• Routine 1: Update forecast category to BEST CASE for opportunities with a Win Probability >= 40% and <60%

• Routine 2: Update forecast category to COMMITED for opportunities with a Win Probability >= 60% and <100%

16
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You can also use a single routine to call a smart action or object function to run if/then/else logic similar to Groovy
script logic.

Note:  Routines are scheduled to run regularly so the opportunity forecast category update might not be immediately
reflected in the sales forecast. If so, you might want to configure the routine to be triggered based on the Field
Updated action type, which will run the routine each time the opportunity win probability is updated. This can be an
important consideration in the final days of a forecasting period.

Groovy Scripts
You can also use Groovy scripts to set the opportunity forecast category to best case or commit. For example, when the
Opportunity win probability is updated, a Groovy script can populate the FORECAST CATGORY field value using a Field
Trigger based on sample logic:

• Win Probability >= 40 and <60 set forecast category to BESTCASE

• Win Probability >= 60 and <100 set forecast category to COMMIT

Here a sample screenshot of a Groovy script:

By default, new opportunities are created with a forecast category = PIPELINE, and when an opportunity is closed as
Won the forecast category = WON, or if the opportunity is closed as Lost, the forecast category = OMIT

17
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Define Custom Dimensions for Filtering and Adjusting
Sales Forecasts  
You can filter Opportunities within your own or your team member's forecast and make summary adjustments to the
best case forecast or committed forecast for you and your direct reports.

The following table outlines the following dimensions and metrics for each of the sales forecast types:

Forecast Type Dimension Metrics

Forecast by Opportunity Owner (Default)
 

Owner (Team Member)
 

• Won

• Committed

• Best Case

• Unforecasted

• Committed Forecast (Won + Committed)

• Best Case Forecast (Won + Committed +
Best Case)

Forecast by Opportunity Revenue
 

• Territory

• Product

• Revenue Type (Revenue Category Type)

• Won

• Committed

• Best Case

• Unforecasted

• Committed Forecast (Won + Committed)

• Best Case Forecast (Won + Committed +
Best Case)

• Overlay Won

• Overlay Committed

• Overlay Best Case

• Overlay Unforecasted

• Overlay Committed Revenue

• Overlay Best Case Forecast

Add a Custom Sales Forecast Metric Dimension
You can add your own custom dimensions to the Sales Forecasting for Redwood UX setup using Sales Forecast
Dimension Metadata (salesForecastDimensionMetadata) REST Service. This REST service is used for capturing
information related to custom dimensions such as the revenue type lookup type (dimension source data), and the
related opportunity or revenue filter fields.

You'll also need to map the custom dimensions using the Sales Forecast Metric Source Dimension Mappings
(salesForecastMetricSourceDimensionMappings) REST Service.

18
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For more information, see Sales Forecast Dimensions REST Endpoints.

Add Filters for Custom Sales Forecast Metric Dimensions
Your sales administrator must add the custom sales forecast metric dimensions for filtering the sales forecast
information in the Sales Forecast Metric Dimensions (ORA_ZSF_DS_METRIC_DIM) lookup type. See Overview of
Lookups for more information about lookups.

Once the custom metric dimension lookup value is added, salespeople can then select the custom dimension from the
drop-down list from the Filter options section of the Configure Sales Forecasting page.

Selecting the Allow multiselect option will allow salespeople to select more than one filter value. Here a sample
Configure Sales Forecasting screenshot from where you enable dimensions for filtering sales forecast opportunity
revenue lines.

Drill Down to Forecast Overviews and Opportunities for
Different Management Levels  
Sales Forecasting for Redwood CX allows VP’s and senior sales managers to view the best case forecast and committed
forecast totals as part of their sales forecast overview. Senior sales managers can drill down below their hierarchical
chain to view the sales forecast overview and opportunities in forecast from the perspective of their direct reports and
team members.

VP and senior managers can view the forecasts of any team member below their direct reports and make summary
adjustments to their own and to their direct reports’ forecast. However, they can’t make summary adjustments to any
level below their direct reports.

19
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They can perform the following from the Action menu (3 horizontal dots (…) ):

• Edit Forecast

• View Opportunities in Forecast

• View Committed Forecast and Best Case Forecast

When a senior sales manager drills through to lower-level managers in the Forecast Overview UI, they can quickly
return to their own view by clicking the Go to My Forecast Overview breadcrumb link. This link will always return the
manager to their own forecast view level, whether they drill down through one or multiple levels below in the hierarchy.

Alternatively, users can click the browser Back button to return to the prior forecast overview.

Extend Sales Forecasting with Configurable Opportunity
Drawer  
Sales managers can view and access key opportunity information for sales forecasts in Redwood UX by using the Edit
Opportunity smart action. Smart actions are contextual actions that are mapped to an object and client application.

Here are the high level steps to set up the Edit Opportunity smart action from Application Composer.

Note:  Before you start, you must have the Manage Sales Forecast from Digital Sales
(ZSF_MANAGE_DIGITAL_SALES_FORECAST) privilege and the View Sales Forecast from Digital Sales
(ZSF_VIEW_DIGITAL_SALES_FORECAST) privilege.

20
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1. Create a sandbox with Application Composer.
2. From the Tools menu select Application Composer.
3. Select Smart Actions.
4. Enable Edit Opportunity smart action by selecting Yes from the Enabled drop-down list.
5. Publish the sandbox.

Here are sample screenshots of the Edit Opportunity smart action that opens the opportunity drawer from where you
can view and make updates to the selected opportunity record.

21



Oracle Fusion Cloud Sales Automation
How do I get started with Sales Forecasting?

Chapter 3
Working With Sales Forecasting

Optionally, you can rename the sales forecast smart action using the User Interface Text tool. See the Tools for Changing
Text section of the Configuring and Extending Applications guide for more details.

22

https://docs.oracle.com/en/cloud/saas/applications-common/24b/oaext/tools-for-changing-text.html
https://docs.oracle.com/en/cloud/saas/applications-common/24b/oaext/tools-for-changing-text.html


Oracle Fusion Cloud Sales Automation
How do I get started with Sales Forecasting?

Chapter 3
Working With Sales Forecasting

You can use VB Studio to configure the fields and layout of the Edit Opportunity drawer. See How can I modify standard
Sales pages in Oracle Visual Builder Studio? and What You Can Configure for more information.

Extend Sales Forecast Opportunity Cards using Oracle
Visual Builder Studio  
You can use Oracle Visual Builder Studio (VB Studio) to extend the information displayed in sales forecast opportunity
cards for sales in the Redwood User Experience. For example, you might want to include more fields in the Opportunity
cards such as the Predicted Win Probability or Sales Stage fields.

This can also be done using the Edit Page in Visual Builder Studio as shown in this sample Card Layout for Sales
Forecasting screenshot.

23

https://docs.oracle.com/en/cloud/saas/sales/famex/index.html
https://docs.oracle.com/en/cloud/saas/sales/famex/index.html
https://docs.oracle.com/en/cloud/saas/sales/famex/what-you-can-configure.html


Oracle Fusion Cloud Sales Automation
How do I get started with Sales Forecasting?

Chapter 3
Working With Sales Forecasting

You can add other team and activity stream information related to each opportunity so that sales managers can view
important opportunity and forecasting information within the sales forecasting UI. Here's an example of an extended
sales forecasting drawer that shows activities from an Opportunity card in the Sales Forecasting UI.

Follow these steps to add the Team Members and Activities tabs to the Sales Forecasting opportunity summary
drawer.

1. From the Sales Forecasting opportunity summary panel, click your profile and select Settings and Actions > 
Edit Page in Visual Builder Studio to open Visual Builder Studio (VBS).

2. Select a workspace and click CX Sales > cx-sales > forecasts > forecasts-line > .
3. Select the showSummaryDrawerExtnTabs constant.
4. Update the showSummaryDrawerExtnTabs array value as required. For example, update as follows:

24
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[{"name":"Team Members","id":"optyTeam"},{"name":"Activities","id":"activityFeed"}]

5. Click Page Designer > Design > Opportunity Tabs Container Layout Rule Set 1.
6. From the Properties window, click + Case to add a new case.
7. Set the condition of the case to $base.constants.showSummaryDrawerExtnTabs.
8. Click + and select New Section.

Note:  The ID should be the same as the ID value set for one of the values in the array updated in Step 5.

Repeat this step for each element in the array you updated in Step 4.
9. Click the JSON tab and change the dissplayProperties in the layout section as follows: displayProperties":

[ "[[ $base.page.variables.summaryExtnTabSelected]]
10. Click the Code tab and in the Template Code section, embed these Opportunity related fragments:

◦ $base.page.variables.currentOpportunityNumber for Opportunity PUID

◦ Number $base.page.variables.currentOpportunityId for Opportunity ID

11. Click the forecasts-overview page.
12. Preview your configuration by clicking the Preview button and verify the page. A local URL is generated in the

browser and you can share this local URL for other users to verify.
13. Click Publish to make your configuration permanent. The changes will be available for users to directly verify

without using the local URL.
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Frequently Asked Questions (FAQs) for Sales Forecasts  
This section contains some frequently asked questions (FAQs) for sales forecasts. Scroll or search to find answers to
common questions.

How are sales forecasts generated?  
Here's how your sales forecasts are generated:

• Opportunities are placed in time periods (quarters) according to their close dates.

• The forecast category on the opportunity or revenue line identifies where unforecasted, best case, committed,
or won opportunity or revenue lines exist within the forecast. For example, an opportunity or revenue line with
a win probably:

◦ Between 0% and 39% is accumulated in the Unforecasted / Pipeline category

◦ Between 40% and 59% is accumulated in the Best Case category

◦ Between 60% and 99% is accumulated in the Committed category

• Won opportunities have 100%-win probability and are added to the Won category.

See About Opportunity Forecast Categories for more information about sales forecast categories. You can also use
routines or Groovy scripts to set the Best Case and Committed forecast categories. See Use Routines and Groovy Scripts
to Set Forecast Category Values for more details.

What sales forecasting tasks can I perform as a sales manager?  
Sales managers, sales VP's, and sales representatives can view their forecasts for opportunities in the active periods.
Your direct reports can only update the underlying opportunity close date, line or product amount, and forecast
category (if available), or other related opportunity information such as the sales stage or win probability.

Here are some tasks that sales managers can perform from Navigator > Redwood Sales > My Forecasts:

• Catch up with updates and prepare for team forecast reviews

• Review the forecast with their team

• Adjust the opportunity amount and forecast category for forecast items (Opportunities)

• Review forecasts with second-line managers and communicate with salespeople and Sales VP

• Make adjustments by changing the best case forecast or committed forecast amount for individual time period
for their own or a direct report's forecast

Note:  Any adjustments made are only visible to the sales manager and their management chain above, but
not visible to their team members in the hierarchy below.
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How do I adjust my sales forecast?  
Sales managers can view and adjust their own and their direct report's forecasts and roll the pipeline up by forecast
category into their quarterly forecast view. In collaboration with salespeople on their team, sales managers can:

• View their Best Case and Committed opportunities or product lines their team want to close in the current
period

This enables you to evaluate and decide what help or coaching team members might need to ensure the
opportunities get moved to the Won forecast category

• View and adjust the committed forecasts

An adjusted badge is displayed to highlight adjustments made to the committed forecast, or opportunities that
make up the committed forecast, made by the sales manager or a team member.

• Click Edit  from the actions menu and make your adjustments.

The adjustment metrics are immediately reflected as highlighted in the My Forecast Overview  page.

Sales managers and sales VPs can click the opportunity name to open a summary of the opportunity in a drawer and
adjust the opportunity amount and forecast category. An adjusted badge is displayed to indicate at a glance that an
adjustment was made to the opportunity.

Can I view reports for my team's forecast based on the territory
hierarchy?  
No. Sales managers responsible for both prime and overlay salespeople can't currently view reports on their and their
team's forecast based on the territory hierarchy.
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How can I share my sales forecast with other members of the
organization?  
As the owner of a sales forecast, you can share your forecast with users who support the sales organization such
as sales operations and administrators. If using sales forecasting by opportunity revenue, you can share your sales
forecasts by adding the user as a forecasting delegate team member on the territory.

Note:  By default, users with the sales administration job role or users with the setup sales forecasting privilege
assigned can view and forecast on behalf of anyone in the reporting hierarchy.

For example, sales operations, administrators and other sales managers can easily forecast as another sales manager.
Let's say a senior sales manager wants one person to update forecasts for everyone in her territory hierarchy. She must
first add that person as a member of the territory team and then select the Forecast Delegate checkbox.

Once the user is added as a forecasting delegate team member on the territory, you must:

1. Run the Refresh Sales Forecast Dimensions process to reflect the territory membership updates.
2. Run the Perform Object Sharing Assignment Rule Processing  process with the following parameters:

◦ Object = Sales Forecast

◦ View Criteria = All Records.

Users with the appropriate privileges can search for the territory they want from the Navigator > Territories area and
from the Territory Team section, they can:

• Add the resource they want to forecast as the sales manager as a member of the sales manager's territory with
the Forecasting Delegate  checkbox selected as highlighted in this sample screenshot.

The sharing of forecasts is only available for sales forecasting by opportunity revenue. However, salespeople can view
forecasts for any resource using sales forecasting by opportunity owner.

Here's a screenshot example of a territory owner sharing their forecast with a resource from another territory.
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What are sales forecast quotas?  
Sales forecast quotas show the period quotas for each resource, in line with the organization’s strategic goals.

Sales Forecasting for Redwood UX shows the quota for each salesperson alongside their sales forecast and compares
the expected forecast with the quota as a quota attainment. Sales managers can view their quota attainment and those
of their team members.

Sales forecast quotas can be manually entered by sales managers or their own quota entered by sales representatives.
Quotas can also be loaded in bulk via Import Management or REST API from the organization’s external quota planning
application.

Note:  There's no rollup of sales quotas up the resource or territory hierarchy.
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Currently, sales forecast quotas aren't intended to be used for:

• The sales organization’s quota setting

• Extracting to third party applications

Who can set sales forecast quotas?  
Administrators with the required privileges can set the sales forecast quotas for resources, in line with the organization’s
strategic goals. Users with ZSF_MANAGE_DIGITAL_SALES_FORECAST_QUOTAS (Manage Sales Forecast Quotas from
Digital Sales (Redwood UX)) can view and edit sales forecast quotas from Redwood UX.

Users with ZSF_EXPORT_IMPORT_DIGITAL_SALES_FORECAST_QUOTAS (Export and Import Sales Forecast Quotas
from Digital Sales (Redwood UX)) privileges can export and import sales forecast quotas from Redwood UX so that they
can be displayed alongside the key sales forecast metrics.

How can I change my sales forecast quota amount?  
Sales representatives and sales managers can change the total amount of their own quotas as follows:

1. From the My Forecast page, click the pencil icon next to the Quota metric card.
2. Change the quota total as needed and click the check mark (OK) icon. You can click the X icon (Cancel) to revert

to the original quota amount.
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4  Sales Forecasting Processes

Generate Sales Forecast Metrics  
After enabling Sales Forecasting for Redwood UX, the Generate Sales Forecast Metrics process is automatically run
without parameters. This process performs the initial calculation of all sales forecasting metrics used throughout your
Redwood UX application.

In addition, you can also run this process to recalculate metrics in case of data corruption or when there’s several
changes to resources, resource hierarchy, territories, territory hierarchy or products.

The process completes the following:

• Creates the forecast periods starting from the current period to the available periods defined in the
GL_PERIODS table.

Note:  The GL_PERIODS table contains the value retrieved from the profile option ZCA_COMMON_CALENDAR. If this
value is changed, forecast periods and metrics must be recreated. This is a read only parameter and might not be set
in the setup REST or UI.

• Uses the default calendar specified by the ZCA_COMMON_CALENDAR profile option.

• Generates the forecast metrics based on the following:

◦ Best Case (BESTCASE)

◦ Committed (COMMIT)

◦ Unforecasted (PIPELINE)

◦ Won (WON)

If you're using the default Forecast by Opportunity Owner method, then the Generate Sales Forecast Metrics process is
used to update resources and the resource hierarchy. If using the Forecast by Opportunity Revenue method, then the
process is used to update territories and the territory hierarchy, and products and the product hierarchy.

Note:  Sales Forecasting for Redwood UX uses the corporate currency as defined in the
ZCA_COMMON_CORPORATE_CURRENCY profile option.

Schedule the Generate Sales Forecast Metrics Process
Typically, you run the Generate Sales Forecast Metrics process once for each forecasting period. You can run this
process more than once.

Run this process:

• At least 2 weeks before the next active period + 1 start date

• Regularly. For example, run daily to refresh the sales forecast information when there’s many resources,
resource hierarchy, territory, territory hierarchy or product changes
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The processing time varies based on the number of opportunities and territories or resources. The period name is
optional.

Name Description Sample Value Optional or Mandatory Notes

Period name The name of the period. Q2-2023 Optional If no period is specified,
 then this process runs for
the current active period
and next period (assuming
the active period parameter
is set to 2)
 
Typically, this process is run
once for each period. When
a period is specified, it runs
only for that period.
 

Refresh Sales Forecast Dimensions  
To reflect the latest information in near real-time for Forecasting for Redwood UX users, you must run the Refresh Sales
Forecast Dimensions process. This process refreshes the sales forecast dimensions and related metrics based on the
changes to the corresponding source records.

Run the process from Navigator > Tools > Scheduled Processes.

Note:  If more than 10% of resources or territories have changed or have been moved following a major resource
or territory alignment, then running the Refresh Sales Forecast Dimensions process will display an error. It's
recommended to first run the Generate Sales Forecast Metrics process directly after any major realignments.

Typically, it's recommended to run this process once per day. If you're using Forecast by Opportunity Revenue type, then
run the process directly after a full run of an opportunity territory assignment process.

See these related topics to change the Sales Forecasting for Redwood UX setup parameters, dimensions and quota
details using REST Services.

• Sales Forecast Parameters: https://docs.oracle.com/en/cloud/saas/sales/faaps/api-sales-forecast-
parameters.html

• Sales Forecast Dimensions: https://docs.oracle.com/en/cloud/saas/sales/faaps/api-sales-forecast-
dimensions.html

• Sales Forecast Quotas: https://docs.oracle.com/en/cloud/saas/sales/faaps/api-sales-forecast-quotas.html

Compress Sales Forecast Metrics  
The Compress Sales Forecast Metrics scheduled process job compresses the summary metrics with the latest
transactional metric information from the underlying forecast data.
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Run the process from Navigator > Tools > Scheduled Processes. The process runs on all data and doesn’t take any
input parameters. It reduces space usage and improves performance by compressing calculated metrics.

Note:  Running the Compress Sales Forecast Metrics process regularly is required to ensure the most recent forecast
information is available in Sales Forecast OTBI reporting.

Typically, you schedule the Compress Sales Forecast Metrics process to run every hour.
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5  Sales Forecasting Reports and Trends

Sales Forecast Reporting by Opportunity and Sales
Quotas  
Sales managers can generate and view reports for their and their team's forecast and quotas for active periods by using
subject areas for transactional Business Intelligence (BI).

You can generate reports for the following key forecast metrics:

• Committed Forecast

• Adjusted Team Rollup

• Opportunity Rollup

• Won, Committed, Best Case, and Unforecasted (pipeline) forecast category metrics

These prebuilt transactional BI subject areas are available to use when creating and editing analyses and reports for
your sales forecasts.

• Sales – Resource Sales Forecast

Report only on sales forecasts by opportunity owner rolling up the resource hierarchy.

• Sales – Resource Sales Quota

Report only on sales forecasts by opportunity owner rolling up the resource hierarchy.

For example, this report contains both the sales forecast and resource sales quota facts for active periods.
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Generate Snapshots of Sales Forecast Metrics and
Adjustments  
Snapshots allow sales managers to view sales forecast trends. Use snapshots to review and access weekly snapshots of
key forecast metrics and adjustments to easily identify changes to your sales forecast commitments since the forecast
was last reviewed, or earlier in a period.

To enable the Generate Sales Forecast Snapshot feature, you must have Manage Sales Forecast from Digital
Sales (ZSF_MANAGE_DIGITAL_SALES_FORECAST) privilege and the View Sales Forecast from Digital Sales
(ZSF_VIEW_DIGITAL_SALES_FORECAST) privilege.

Follow these steps:

1. Navigate to Redwood Sales > My Forecasts and from the Actions drop-down list, select Configure
Forecasting.
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2. Select the Generate Snapshots option as highlighted in this screenshot:

3. Click Continue until you reach the final Review and submit step.
4. Review and click Submit.

To see the trending information driven off snapshots click the Changes Since filter chip in the forecast pages.

By default, the process runs automatically every week on Saturdays at 2.00 AM UTC. This process captures forecast
metrics such as committed forecasts, best case forecast, best case, committed, unforecasted, and so on.

Also, sales managers can view and adjust their sales forecast using a best case forecast summarized metric. This
represents the sum of opportunities or revenue lines for Best Case, Commit and Won forecast categories. For example,
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here's an example of a screen where you can view increases or decreases in your key forecast metrics since last week’s
snapshot.

38



Oracle Fusion Cloud Sales Automation
How do I get started with Sales Forecasting?

Chapter 6
Troubleshooting Tips for Sales Forecasts

6  Troubleshooting Tips for Sales Forecasts

Why can't I see resource or territory hierarchy or forecast
data?  
As a sales administrator, you must be assigned a data security policy for the Sales Administrator role or an equivalent
custom job role to view resource and territory hierarchies and forecast data from the Forecast overview page.

You can edit a copy of the Sales Administrator role from the Security Console and add the Sales Forecast
(FSF_DS_PARTICIPANTRF_DN_VIEW) security policy to the role. Select All values from the Data Set drop-down list and from
the Actions menu, enable all 3 menu items and select OK.

Why aren't my Opportunity updates reflected in Sales
Forecasting?  
Sales forecasting uses Signals to indicate when opportunities get updated but sometimes the trigger might fail to
sync and reflect the changes in sales forecasting. If this happens, you can run the Compress Sales Forecast Metrics
scheduled process with the INCREMENTAL_SYNC=Y diagnostic parameter set to Y.
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